End-User License Agreement

IMPORTANT: READ THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING.  
Product: DefSim Personal Edition

IMPORTANT: READ THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING ABOVE-MENTIONED PRODUCT ("Software").

You may install and use the Software only when you agree with the terms of this license agreement.

If you do not agree with the terms of this license agreement, you may not install the Software.

TESTONICA LAB OU (hereinafter referred to as "TESTONICA") grants customers who obtain DefSim Measurement Box (hereinafter referred to as "DefSim Hardware") a nonexclusive, limited license to install and use the Software, which includes the software itself as well as accompanying printed documents, upon the terms set forth hereunder.

1. Grant of License

1. You may install and use the Software for the only purpose of utilizing your DefSim Hardware.
2. You are allowed to make copies of the Software solely for backup purposes.
3. You agree that TESTONICA may audit your use of the Software for compliance with these terms at any time, upon reasonable notice.

2. Any Right

1. All rights, including but not limited to copyrights and other intellectual property rights, to the Software are owned by TESTONICA or third party licensors.
2. The Software is protected by copyright laws, any other law or any international treaty.

3. RESTRICTIONS

1. Except as expressly permitted by this agreement and/or applicable laws;
   (i) You may not copy, modify, merge, revise or enhance the Software in any way.
   (ii) You may not decompile, disassemble, reverse engineer or otherwise attempt to discover the Software’s source code.
   (iii) You may not make others install and/or use the Software by rental, lease, transfer, sub-license or any other method.
   (iv) You may not place the Software onto a server so that it is accessible via a public network.

2. You agree that you will not export the Software in any form in violation of any applicable laws and regulations regarding export control of the country in which you obtained the Software.

4. Warranty and Liability

1. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, TESTONICA PROVIDES TO YOU THE SOFTWARE "AS IS"; AND TESTONICA HEREBY DISCLAIMS WITH RESPECT TO THE SOFTWARE ALL WARRANTIES AND CONDITIONS, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY (IF ANY) WARRANTIES OR CONDITIONS OF OR RELATED TO: NON-INFRINGEMENT, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, LACK OF VIRUS, ACCURACY OR COMPLETENESS OF RESPONSES, RESULTS, LACK OF NEGLIGENCE.
2. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL TESTONICA BE LIABLE FOR ANY DIRECT OR INDIRECT DAMAGES WHATSOEVER (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR: LOSS OF PROFITS, LOSS OF CONFIDENTIAL OR OTHER INFORMATION, BUSINESS INTERRUPTION) ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF TESTONICA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

3. TESTONICA HAS NO OBLIGATION TO RESPOND TO ANY INQUIRY OR TO PROVIDE ANY SERVICE REGARDING THE INSTALLATION AND/OR USING THE SOFTWARE.

5. TERMINATION

1. You may terminate this agreement at any time by destroying the Software and all your copies of it, as well as all other related documents.
2. TESTONICA may terminate this agreement if you fail to comply with these terms. Upon such termination, you agree to destroy the Software and all your copies of it, as well as all other related documents.

6. Applicable laws

1. This license agreement is governed by the laws of Republic of Estonia.
2. Any dispute, that cannot be settled amicably between TESTONICA and the End User, shall be settled by the International Court in Stockholm in accordance with the relevant laws of the Republic of Estonia.

7. Severability
In the event that any part or parts of this agreement shall be held illegal or null and void by any court or administrative body of competent jurisdiction, such determination shall not affect the remaining parts of this agreement, and they shall remain in full force and effect as if such part or parts determined illegal or void had not been included.

In case of further questions or technical problems please contact:

Testonica Lab OU
EMAIL: info@testonica.com
PHONE: +372 517 9012

Rev. Dec 2005
3.7.1. Device options ................................................................. 22
3.8. Working with multiple devices ........................................... 24
3.9. Log window ........................................................................... 24
4. Additional information .............................................................. 26
  4.1. Test file format ................................................................. 26
5. Troubleshooting .......................................................................... 28
  5.1. Common problems and their solutions ......................... 28
    5.1.1. Installation problems .............................................. 28
    5.1.2. Software does not start ........................................ 28
    5.1.3. Wrong JRE version ................................................ 28
    5.1.4. Updating device information ................................. 29
    5.1.5. Hardware not found .............................................. 29
  5.2. Known issues ........................................................................ 31
  5.3. Asking for support ............................................................. 32
1. INTRODUCTION

1.1. About DefSim Personal

The presented product provides user with an integrated measurement environment for physical defect study in CMOS circuits.

*DefSim* is an integrated circuit (IC) and a measurement environment for experimental study of CMOS defects. The central element of the *DefSim* environment is an educational IC with a large variety of shorts and opens physically inserted into a set of simple digital circuits. The IC is attached to a dedicated measurement box serving as an interface to the computer. The box supports two measurement modes - voltage and **I\text{DDQ}** testing.

*DefSim Personal* edition allows you to experiment with various aspects of IC testing shortly after connecting hardware to host computer.

1.2. About this document

This User’s Guide contains essential information on using *DefSim Personal* product. The product consist of the following hardware and software parts:

- Hardware: DefSim Measure Board (version 2.0)
- Software: DefSim Personal software environment

*Note:* there are two different products released under “DefSim” name: *DefSim Personal* and *DefSim Server*. If you are using the server one please refer to the corresponded manual.

Before using DefSim Personal please read carefully “End User License Agreement” provided on page 2.

This document is divided into several sections as follows:

- *Installing DefSim Personal* – guides you through the installation process, contains information about removing the software from computer.
- *Using DefSim* – contains all essential information on how to use the product.
- *Additional information* – provides the specification of file formats used in *DefSim*.
- *Troubleshooting* – the last section contains information about common problems and known issues on using this product.
2. INSTALLING DefSim PERSONAL

2.1. System requirements

Please check the following minimal system requirements before installing DefSim Personal on your computer:

- Intel-compatible computer
- Microsoft Windows® 2000/XP (only windows platform is currently supported)
- Java Runtime Environment 5.0 (not included with DefSim distribution package)
- 1MB free space on HDD
- 64MB free RAM
- Free USB port (to attach the hardware)

Please pay special attention to the availability of correct version of Java on the target computer. DefSim Personal can be run properly only if Java Runtime Environment (JRE) version 5.0 (or higher) is installed. For obtaining JRE 5.0 please refer to the official site of Sun Microsystems for downloading free installation package:

http://java.sun.com/j2se/1.5.0/download.jsp

2.2. Installation guide

DefSim Personal installation process consist of hardware installation and setup of software environment. The both installation procedures are described below.

2.2.1. Software installation

Before you start working with DefSim, a special a software environment should be properly installed to your computer. Just run “DefSim_Installer.exe” file and the built-in setup wizard will quickly guide your through the installation process.

Note: if you have previous version of DefSim Personal software installed before you do not need to uninstall it first. A new version can be installed directly over the previous one.

On “Choose Components” step (Fig. 1), you can select the modules of the software that will be installed on you system. In the most cases, you should leave both components selected for correct installation.
Fig. 1 – DefSim software installation: Choose Components

If you have already used DefSim Personal before and want to upgrade from the previous version, select only “Install DefSim Personal” to leave the driver unchanged. On the other hand, if you have no driver installed or the driver was installed incorrectly – you can select only “DefSim Driver” component.

During the installation Windows can display a warning about unsigned hardware driver (Fig. 2). choose “Continue Anyway” option in order to finish the installation successfully.

Fig. 2 – Installation warning
After the software installation is finished, a new program group “DefSim Personal” will appear in Windows Start Menu and the program’s icon will be added to your desktop.

Next, proceed with hardware setup to finish DefSim Personal installation.

2.2.2. Hardware installation

DefSim Personal hardware package consist of the following items (see Fig. 3):

- DefSim Measure Board
- USB cable
- Service key

Note: before DefSim Measure Board will be plugged into computer, please check that the board lock is in the “Measurement” position (see Fig. 3). If not, use the service key to switch to the “Measurement” mode as it shown below. When the board is in the “Measurement” mode, the “Service” red indicator will not be lighted up. Service mode should be used only for re-configuring board internal firmware at the authorized service center.

To connect your board, you need to have one USB port available on host computer. Plug “Connector 1” of DefSim USB cable into the special socket on the back-side of the board. “Connector 2” should be plugged into USB-port of host computer.

![Fig. 3 – DefSim hardware installation](image-url)
Note: you can freely connect/disconnect board even if computer is working or the board is running experiments. This should not make any harm to your DefSim hardware.

After the board is connected all the power supply indicators (yellow lights: “+15V”, “+9V”, “+3.3V”) will go on. If the driver was installed properly, “BiCM”, “CUT” and “Logic” indicators should light green, whether red lights “Testing” should go off (see Fig. 4).

Fig. 4 – DefSim Measure Board

2.3. Uninstalling DefSim software

You can uninstall DefSim Personal software environment from computer by selecting “Uninstall DefSim Personal” command in “DefSim Personal” program group of you Windows Start Menu.

Another way to run removal process is to select “DefSim Personal” in “Add or Remove Programs” applet of Windows Control Panel (Start Menu ➔ Control Panel ➔ Add or Remove Programs ➔ DefSim Personal ➔ Remove).

As result of both actions, removal process will be initiated.
3. USING DEF SIM PERSONAL

3.1. Getting started

First of all, plug-in DefSim Measure Board to your computer (if it is not plugged-in already). To run DefSim Personal just double-click its icon on your desktop (or select program’s icon in “DefSim Personal” command group of Start Menu). If the software was started successfully, the main window (Fig. 5) of DefSim environment will appear on screen. If “Run” button is green, it means that software has detected at least one DefSim board plugged into computer and is ready to run experiments.

Fig. 5 – DefSim Personal software environment
If the program is not starting properly, *DefSim Measure Board* is not detected or there are error messages during initialization phase, please refer to section 5 ("Troubleshooting") to check the common problems and their solutions.

### 3.1.1. Main window

Here we will give a brief overview of basic control elements of the main window of *DefSim Personal* (shown in Fig. 6):

- **Circuit Selector** – allows you to select circuit to work with. There are currently 18 different circuits implemented in *DefSim* chip. The logic-level schematic of currently selected circuit is represented in *Schematic Window*.

- **Input Vectors Panel** – lets you enter one or several binary test vectors that will be supplied to the currently selected circuit as a test set.

- **Show Transistor Level Schematic** button – brings up transistor-level representation of selected circuit. Note that for some circuits there are no transistor-level schematic available – in the last case this button will become disabled (grayed).

- **Measurement Options** – used to configure the mode of circuit testing. There are several modes of testing supported by *DefSim*.

- **ATPG Panel** – provides tools for Automatic Test Pattern Generation (ATPG).

- **Menu bar** – contains additional commands to operate with the software.

- **Status bar** – displays information about current state of the program (shown in the left part) together with additional messages (that are shown on the right). The program can be in the one of the following states: “Initializing” (start-up phase), “Ready” (ready to run tests), “Running” (test is currently in progress) and “Error” (problems with hardware or test was interrupted manually).

![Fig. 6 – Basic control elements](image)
3.1.2. How to test defects

Usual workflow process of testing defects is presented in Fig. 7.

1. First of all, you should select circuit you want to test (using Circuit Selector).
2. Then you should enter or generate a test set that will be applied to the inputs of circuit (use “Input Vector” panel or “Generate” panel).
3. Next step is selection of measurement options: scope of defects and mode of test.
5. After test is finished – you will be provided with a report about the results of experiment.

All the sequence of steps can be repeated several times until the needed goal is reached. We will describe each step in details below.

![Fig. 7 – Workflow process](image)

3.1.3. Selecting circuit

To change circuit just select one you need from the drop-down list of circuit selector (Fig. 8). The name of circuit describes its functionality. For example “NOR(A, B, C)” means NOR gate with three inputs (3-bit wide): A, B and C. When the circuit is selected its logic-level schematic will be immediately displayed. Remark “opens” in the description of some circuits means that they have only open defects implemented.
Press “Show Transistor Level Schematic” button – to view transistor-level representation of selected circuit. Note that for some circuits there are no transistor-level schematic available – in the last case this button will become disabled (grayed).

### 3.1.4. Specifying test sequence

Vectors should be entered line by line (each line is interpreted as a separate vector in the sequence) by using “0” and “1” symbols (Fig. 9). The length of each vector should be equal to the number of inputs of selected circuit. Header “CBA” shows the order of input signals.
Instead of entering test set manually you can use means of Automatic Test Pattern Generation (ATPG). See section 3.2 for details.

You can always save entered/generated test sequence to file by using “Save...” button. Later the test set can be restored by opening this test file.

3.1.5. Measurement options

There are several modes that can be used to test the circuit (Fig. 10).

First of all you can limit the scope of defects to test by selecting one of the following options:

- **All defects** – all possible defects will be tested in selected circuit.
- **All stuck-at faults** – only defects that corresponds to Stuck-At Fault (SAF) defect model will be tested.
- **Single defect** – lets you select a specific defect from the list.

**Note:** some circuits can contain only open (non-SAF) defects. In the last case “All stuck-at faults” test mode will be not available.

Test itself can be performed using one of the two methods:

- **Voltage testing** – default, “Activate IDQ” check box is in the unchecked state.
- **Current IDQ testing** – “Activate IDQ” check box is selected.

3.1.6. Running test

To run test click the green “Run” button. The test will be started and you will see that the red light “Testing” on you DefSim board is blinking. After finishing the test, a new window with results of performed experiment will be opened. If you want to interrupt the test before it is ended, click red “Stop” button (but no partial results will be available in that case).

**Note:** the situation when “Run” button is not active means that DefSim was unable to detect hardware at the start-up. One of the possible reasons is that you have not plugged DefSim Measure Board to host computer before loading DefSim Personal. To solve this problem you have to update information about hardware manually (see section 5.1.4). In case of other problems refer to troubleshooting section 5.
Note: before running the test software will automatically correct the vectors with invalid lengths. If some vectors have wrong length – they will be automatically adjusted (missing values will be padded by zeros).

3.1.7. Interpreting results (multiple defects)

The next figure (Fig. 11) shows results obtained from experiment with “NO3: NOR(A, B, C)” circuit. Three vectors were applied to inputs of the circuit (table columns: “101”, “001” and “000”). The circuit was tested on SAF defects only (“All Stuck-at faults” option was selected) in the voltage testing (“Activate IDDQ” flag was unchecked) mode.

![Fault table]

The leftmost column contains the list of the names of all defects on that the circuit was tested. The next columns contain information about the detection of each of the defects by every vector. So the symbol “0” in the intersection of row “B/vdd” (name of the defect) and column “001” (test vector) means that this defect was not detected by “001” test vector. The red symbol “1” in the same row (“B/vdd”) and next column “000” signals that the defect “B/vdd” was detected by test vector “000”.

The last column reports the coverage of detection of defects. If at least one of the test vectors detect the defect – there will be red “1” in the coverage vector. The coverage value “75.000%” means that ¾ of all defects in the list were discovered by supplied test set.

The last rows of the table (after blue mark “Outputs”) show information about correct output values. For instance, in case of second vector “001” the correct value of output Q was “0” (low).

You can always save or print results of experiment by pressing appropriate buttons (“Save…” and “Print…” ) of “Results” window.
Note: the structure of results window is the same when you are testing all defects or SAF defects only for both voltage (“Activate $I_{DDQ}$” checked) and current (“Activate $I_{DDQ}$” unchecked) testing modes.

3.1.8. Interpreting results (single defect)

The results of test that was applied to defect “A/gnd” of circuit “NO3: NOR(A, B, C)” in the voltage testing mode (“Activate $I_{DDQ}$” flag is unchecked) are presented in Fig. 12. As in the previous example the same test set was used (vectors “101”, “001”, “000”).

![Fig. 12 – Experiment results: single defect](image)

Each row in the window corresponds to test vector from the test set. The first column lists all the test vectors were passed to the device (heading “CBA” informs us about the order of inputs). The last column indicates whether the selected defect was detected (“FAIL” condition) by the vector or not (“PASS” condition). The failed vectors are highlighted by red color.

The PASS/FAIL condition is determined by comparing of expected output value $Q$ (correct value) with actually received output during the test. That is shown in column “$Q$”. Symbols “0” and “1” mean the expected values of the output $Q$. Marks “OK” or “Fail” indicate if the actual value of output $Q$ (that was received during the test) was correct or not. If at least one of the outputs gets incorrect value (“Fail”) then the corresponded test will be marked as “FAIL”.

For the current testing mode (“Activate $I_{DDQ}$” flag selected) the results window is quite similar (Fig. 13).
The only difference here, is that current testing is not dependant on correct/incorrect values of circuit outputs. The PASS/FAIL condition will be determined using means of $I_{DDQ}$ test, not by the comparing of output signals. For this reason, here we will have no OK/Fail marks for the outputs.

### 3.2. Using test sequence generators

The Automatic Test Pattern Generation (ATPG) methods can help you in the task of preparing test set for circuit testing. There are three ATPG algorithms implemented in DefSim software (see “Generate” panel, Fig. 14).

By pressing a button in this panel you will receive test set generated by using corresponded ATPG algorithm. In the next sections we will study each of algorithms separately.

#### 3.2.1. SAF ATPG

A special ATPG algorithm will be used to generate set of input vectors that will test all SAF-type (Stuck-at fault) defects. Press “SAF ATPG” button to get such test set for currently selected circuit.
3.2.2. Exhaustive test

Exhaustive test set ("Exhaustive Test" button) will contain all the possible input test vectors for selected circuit. For example for 3-input “NOR3(A, B, C)” circuit the following vectors will be generated:

000
001
010
...
111

($2^3 = 8$ vectors in total).

Note: the exhaustive test do not guarantee 100% defect coverage. Several types of real CMOS defects behave in such a way that they can be detected only in case of set of conditions (not only currently supplied test vector). So, there can be a such situation when you have to prepare a long sequence of test vectors just to detect one defect.

3.2.3. Random test

By pressing “Random Test” button you will get a number of test vectors that were generated randomly. The desired quantity of random vectors can be adjusted using the field located next to the button. The length of each vector will be equal to the number of inputs in currently selected circuit.

Note: the random ATPG can generate identical vectors multiple times, therefore generated test sequence will contain not only unique vectors. This was made for the sake of testing non-SAF type of defects.

3.3. Switching between results

In the case when a lot of experiments was made during one session, there can be difficult to switch between the obtained results. For that case use Window command of DefSim menu (Fig. 15) where results of all experiments are listed. Select the experiment you are interested in and the window with results become active.
The list of results is sorted by the time of making experiment. Using this menu you can also minimize all results windows ("Minimize All" command) or close them ("Close All" command). “Close Saved” command will close only these experiment results that were saved by the user (they are marked by a special string: “[saved]”).

3.4. Saving results

You can save the results of experiment just by clicking “Save…” button in results window (see Fig. 11 and Fig. 12). There are three options how the results can be saved (in case of testing of multiple defects):

- **Test patterns and faults** – saves input test vectors (test set), correct output values and fault table information (default format).
- **Test patterns only** – saves only input vectors (test set) and correct output values.
- **Input vectors only** – saves only input vectors (test set).

In all cases information is saved in a special .tst file format (see section 4.1 for details). These files can be also opened in “Input Vectors” panel to restore the saved test set.

Results of experiment with single-defect can be saved only in a plain text form.

3.4.1. Saving all results

If you want to save all results at once, select “Save All Results…” command of menu “File”. The following dialog window will be displayed (Fig. 16):
All the active results of experiments are placed into the list with corresponded file names. You can click on each list item to select or deselect it (only selected results will be saved). By default, all unsaved results are selected. To change the directory where the files will be stored press “Change…” button.

The names of files are constructed by using the template below:

\[
\text{<circuit name>_<measurement options>_<number of experiment>}
\]

- \textit{circuit name} – the name of circuit on which the experiment was performed.
- \textit{measurement options} – mode of testing that was used during experiment.
- \textit{number of experiment} – ordinal number of experiment results.

So for third experiment with “NO3” circuit in the single defect mode (where third defect was selected for testing) and with I\textsubscript{DDQ} activated we will have: “NO3\_defect\_3\_iddq\_3.txt” file.

\textbf{Note:} all results will be saved in their default formats. See previous section (3.4) for additional information about file formats used in DefSim.

### 3.5. Printing

To print results separately, press the “Print…” button in results window (see Fig. 11 and Fig. 12).

If you want to print all results at once, select “Print All Results…” command from “File” menu. In the last case you will still get each result printed on separate page.
3.6. Fault table layout

The default layout that is used for displaying fault table in Results Window is the following: vectors are displayed on the top of table (as names of columns) and defects on the left (as names of rows). But you can change this by selecting “Fault Table: Defects on Top” item from “Options” menu. After this layout of all tables will be changed (see Fig. 17):

This style of displaying is more useful when you have results of an experiment with big number of vectors in test set. You can always restore original layout by selecting “Fault Table: Vectors on Top” command.

Note: all windows with results of experiments on multiple defects (All defects/All stuck-at faults measurement modes) are affected to changing the style of layout. There is no way to change layout of separate result window. The results of experiments on single defects are not affected to changing the layout at all (since there are no such tables).

3.7. Configuring DefSim Personal

You can configure DefSim Personal using “Preferences...” command in “Options” menu. There are two groups of options available:

- **General preferences** – allow you to change the default directory where results of experiments will be stored.
- **Device options** – is used for tuning hardware-related settings.

3.7.1. Device options

The dialog window with device setting is displayed in Fig. 18.
The “Available devices” item lists all DefSim Measure Boards that are detected to be connected to computer. Here you can select the device you want to experiment with. If you are connecting/disconnecting DefSim hardware when the software is running, press “Update Device List” button to refresh the information about available devices.

In this dialog you can also change the way of communication with DefSim hardware. There are two access methods implemented:

- **Built-in access module** – uses internal protocol to communicate with DefSim hardware. This is default and preferred way of communication.
- **External module** – uses a separate program that runs experiments and then passes data to DefSim software. Should be used only in special cases or when the built-in module does not work. In that case you can also configure which communication module should be used. The default module that is included with DefSim Personal distribution package will be used when “Default path” checkbox is selected. If you want to use another one, deselect “Default path” and specify the location of external module by clicking “Browse…” button.

Fig. 18 – Device settings
Note: we are not responsible for the consequences of using external modules that were created outside of Testonica Lab. For this reason, it is strongly recommended to always use “Built-in access module” option.

3.8. Working with multiple devices

You can work with multiple DefSim Measure Boards connected to single computer at the same time. To determine which of devices is currently used go to the “Device” tab-panel of “Preferences” dialog (“Options” ➤ “Preferences…” ➤ “Device”, see section 3.7.1). Use the same dialog to switch to another board.

3.9. Log window

During working session, the software constantly collects information about occurred events and errors into special Log window. To make log window visible on screen, select “Log window” checkbox from “Options” menu (Fig. 19).

![Fig. 19 – Making log window visible](image)

After this a window that contain all recorded events will appear (Fig. 20). To save whole log to text file press “Save…” button.
Information about logged events can help us to solve various problematic issues of DefSim software. If you are experiencing problems while working with DefSim Personal try to save log file and send it to our support team together with description of problem (see section 5.3).
4. ADDITIONAL INFORMATION

4.1. Test file format

The following format is used for storing information about test sequence, output values and detected defects.

Test patterns files (.tst files) have a line-based format.

The format has the following syntax:

```
.VECTORS <vectorsCount>
<testPatterns>
[defectTable]
```

*testPatterns* are rows containing the test patterns. Each character in a row represents an input or output signal. The order of the signals is the same as in DefSim software. The following notation is used:

- Ŷ For input signals: '1' - logical one, '0' - logical zero.
- Ŷ For output signals: 'H' - logical one, 'L' - logical zero.

Output signals can be omitted.

*defectTable* has the following format:

```
.TABLE
<table>
.FAULTS
<defects>
.COVERAGE
<detectedDefects> / <totalDefects> = <percentage> %
```

Each row in *table* corresponds to a test pattern and each column to a specific defect of circuit. The order of the defects is the same as used in DefSim software.

The following notation is used:

- Ŷ 'X' – this defect is not detected by the test pattern
- Ŷ 'I' – this defect is detected by the test pattern
defects – is a row of characters. Each character corresponds to a specific defect of circuit. The order of the defects is the same as previously used for construction of fault table.

The following notation is used:

\[ \hat{y} 'X' \] – this defect is not detected by the whole test set.

\[ \hat{y} 'l' \] – this defect is detected by the test set.

detectedDefects - is an integer indicating the number of defects under consideration.
totalDefects - indicates the number of detected defects.

percentage - is a floating point number, showing the defect coverage in percents.
5. TROUBLESHOOTING

5.1. Common problems and their solutions

In this section the common problems of using of the software are listed. Please study this section carefully if you are experiencing troubles during working with DefSim Personal. If you have not found the solution, please consult with our support.

5.1.1. Installation problems

Please check if you have downloaded the installation file correctly. DefSim Personal installation files are named by using the following convention:

\[\text{DefSim}_{<\text{version}>}_\text{Installer.exe}\]

Where \(<\text{version}>\) is substituted by exact version number of the software. You can always download the newest version of DefSim Personal from our website: http://www.testonica.com

5.1.2. Software does not start

You should have Java Runtime Environment (JRE) version 5.0 (or higher) installed properly in order to be able to run the software. For obtaining JRE 5.0 please refer to the official site of Sun Microsystems for downloading free installation package:

http://java.sun.com/j2se/1.5.0/download.jsp

To determine if JRE is installed correctly or not, go to the Windows Command Prompt (select Start à Run, then type cmd and hit Enter), type the following command in the opened window and hit Enter:

\[\text{java } -\text{version}\]

If JRE was installed correctly, similar text should appear on the screen:

\[\text{java version "1.5.0_05"}\]

Where symbols “1.5.0” mean that you have JRE version 5.0 installed.

5.1.3. Wrong JRE version

After starting the software, the following warning appears on the screen (Fig. 21):
This means that the version of your Java Runtime Environment is too old. To update your JRE, please follow the recommendations given in the previous section (5.1.2).

5.1.4. Updating device information

There can be the situation when the software was started successfully but “Run” button is not active. This means that the software was unable to detect DefSim hardware at start-up. One of the possible reasons is that you have not plugged DefSim Measure Board to computer before loading DefSim software. In the last case you need to update information about hardware manually.

Click “Options” menu and select “Preferences…” command in it. The preferences dialog will appear. Click “Device” icon to switch to the device-related settings tab-panel. In the device settings panel (see Fig. 18) click “Update Device List” button. The list of available devices will be updated and the first detected device will be selected. Click “OK” to continue work with DefSim.

If there will be an error during enumeration of devices (or in case of other problems with hardware), please refer to the next troubleshooting section 5.1.5.

5.1.5. Hardware not found

First of all, check that DefSim Measure Board is plugged-in and the power indicators (yellow lights: “+15V”, “+9V”, “+3.3V”) are lighted on (see Fig. 4). The state when lights are off, means either your USB port is does not function properly or DefSim Measure Board is out of order.

If power indicators are OK, you have to check that board is correctly detected by Windows. Go to Windows Device Manager (Start Menu ➔ Control Panel ➔ System, select Hardware tab and click Device Manager) and open “Universal Serial Bus controller” group. If Windows has detected the board correctly you will see “WUoT Defsim Measure Board (ver2.0)” device in the list (Fig. 22):
In case of absence of such device in the list or if this device has a warning sign (yellow exclamation) you should try to reinstall DefSim driver again. Firstly, try to run DefSim installation again (see section 2.2.1) and select only “Install DefSim driver” item on “Choose Components” step (Fig. 1).

If this does not solve you problem, try to reinstall driver manually. For that, connect you DefSim Measure Board to computer. Then, go to the directory, where DefSim Personal is installed (usually “C:\Program Files\DefSim Personal”) and open “drivers\win32” sub-directory.

Copy file “Firmware.bin” (BIN file) that is located there to “C:\Windows\System32\Drivers” directory (we assume that “C:\Windows” is the root folder where Windows is installed). Then right-click on the “defsim.inf” (Setup Information) file and choose “Install” command from the list (Fig. 23). If Windows asks you for the directory where the driver files are located, point to the same folder (“drivers\win32” in the path of DefSim Personal installation).
5.2. Known issues

The problems that are listed below can occur during working with the software.

Ø Some defects are detected only sometimes (not constantly).

Yes and it is not error. Several types of real CMOS defects behave in such a way that they can be detected only in case of set of conditions (not only currently supplied test vector). So it can be a such situation when you have to prepare a long sequence of test vectors in order to detect such defects.

Ø Software/board stop responding after a set of experiments.

This can happen sometimes with DefSim hardware. If the board is stopped to respond just disconnect USB cable and plug it again after a few seconds. During this operation, the software can signal an error about failed experiment. After that you can continue to work with your board.

Ø Values of outputs of circuit are different when using “Built-in access module” and “External module” in “All defects” or “Stuck-at faults” testing mode if IDDQ testing is activated.

Because of technical reasons external module cannot pass correct output values to DefSim Personal software during IDDQ test. As consequence, the output values will be always in the “high” state when you test defects using IDDQ mode if “External module” was selected for communicating with the device. Note that correct values of outputs are not used for detecting defects in the case of current IDDQ testing.

Fig. 23 – Installing the driver manually
5.3. Asking for support

When you have decided to consult with our support for solving problems with *DefSim Personal*, please prepare additional information about your issue.

If the problem was occurred during work with *DefSim Personal* software, save the contents of *Log window* into file and send it to us with corresponded comments. For additional information about event logging please refer to section 3.9.

In case, if problem occurred before the software was started collect the information about the system you are using (operation system type and version, Java Runtime Environment exact version, path to *DefSim* installation, *DefSim Personal* version that was used, etc). Also we ask you to compose a detailed description of your problem.

Our support team is always glad to help you!